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NEW QUESTION 1

- (Exam Topic 1)

You need to embed the check-in solution into the communication solution. To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

What must you use to embed the check-in solution? v
Visual Studio
Power Apps Web Studio
Al Builder
Common Data Service
Where must the check-in solution be available within the v
communication solution? chat section of the solution

Microsoft 365 Apps selection grid
in an embedded webpage
in atab

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Graphical user interface, application, Word Description automatically generated

Box 1: Power Apps Web Studio

Scenario: The check-in solution must continue to function if there are internet issues. If the self-service kiosks are not available, staff must be able to use the check-
in solution from within their communication solution.

PowerApps Studio is a browser application used to edit your apps. PowerApps Studio includes a

drag-and-drop canvas in the center of the screen and a screen or object list pane on the left. Properties, Rules, and Advanced Properties for selected screens or
controls are displayed in the right pane.

Box 2:in a tab

You can customize the Teams experience by adding Power Apps canvas apps to your channels in Teams using the PowerApps tab.

NEW QUESTION 2
- (Exam Topic 1)
You need to design the resort portal to meet the business requirements. Which data source should you use?

A. Microsoft Excel

B. Azure SQL Database
C. SQL Server

D. Common Data Service

Answer: A

NEW QUESTION 3

- (Exam Topic 1)

You need to design and create the solution for gathering contact information from guests for marketing purposes.

What should you use? To answer, select the appropriate options In the answer area. NOTE: Each correct selection is worth one point.

Action Solution

Extract business card data v
Al Builder

Common Data Service

Power Virtual Agents

Power Automate

Implement the contact gathering solution v
Create a new entity extraction component

Integrate the solution with Azure Cognitive Semnvices.
Use a prebuilt Al model.

A. Mastered
B. Not Mastered

Answer: A

Explanation:
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Action Solution

Extract business card data o =
| Al Builder'

Common Data Service
Power Virtual Agents

Fower Automate

Implement the contact gathering solution. o
Create a new entity extraction component.

Integrate the solutjon with Azure Cognitive Senvices.
|Use a prebuilt Al model.

—

NEW QUESTION 4
- (Exam Topic 1)
You need to create the FAQ solution content What should you do first?

A. Al Builder

B. Suggest topics
C. Automate

D. Trigger phrases

Answer: B

Explanation:
You need to make sure there are three main steps need to do while doing import FAQ and add the topic to your bot application.

> Import Suggested Topics from FAQ webpage.
> Add a topic.

> Enable the topics Reference:
https://social.technet.microsoft.com/wiki/contents/articles/53820.power-virtual-agents-fag-chatbot.aspx

NEW QUESTION 5

- (Exam Topic 1)

You need to design the chat solution to answer the inquiry from Guestl.

Which three components can you use? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. Variables

B. Escalations
C. Smart match
D. Synonyms
E. Topics

Answer: ACD

Explanation:

Scenario: Guestl inquires about snow conditions several times during each day of their stay.

Variables let you save responses from your customers in a conversation with your bot so that you can reuse them later in the conversation.

Synonyms allows you to manually expand the matching logic by adding synonyms. Smart match and synonyms seamlessly work together to make your bot even
smarter.

Reference:

https://docs.microsoft.com/en-us/power-virtual-agents/authoring-variables

https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling

NEW QUESTION 6

- (Exam Topic 1)

You need to design the resort portal's email registration process.

Which solutions should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

Requirement Solution

Implement the invitation code v
redemption process Auto-populate the invitation code field on the sign-in screen from the email link

Embed the imatation code in the email ink URL
Send the customer their username and temporary password in the email link.

Validate the user's email v
Two-factor authentication

Azure Active Directory authentication

Social prowider sign-in

Imatation code sign-up
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A. Mastered
B. Not Mastered

Answer: A
Explanation:
Requirement Solution
Implement the invitation code -
redemption process. | Auto-populate the invitation code field on the sign-in screen from the email fink.
| Embed the invitation code in the email link URL. |
Send the customer their usemame and temporary password in the email link.

Validate the user's email v

Two-factor authentication
Azure Active Directory authentication

| Invitation code sign-up |

NEW QUESTION 7

- (Exam Topic 1)

You need to design the guest check-in solution.

Which technologies should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
You need to design the guest check-in solution.

Answer Area

Requirement Technology

Develop the base check-in solution. Xamann app
Power Apps portal
Model-driven app
Canvas app

Access the check-in solution on the check-in devices

A(EEE‘IS the check-in solution on the check-in Lj'E"lrﬂ:ES Traditional dgik‘[gp aﬂphfa“nn
Web browser

Power Apps mobile app
Dynamics 365 for phones and tablets

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Canvas app,

Power Apps mobile app
https://docs.microsoft.com/en-us/power-apps/maker/canvas-apps/offline-apps

NEW QUESTION 8
- (Exam Topic 2)
You need to coordinate updates and deployment for managed solutions containing completed work without disrupting the system.
What should you do? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.
Deployment option for changes to an unrelated table

Deploy a patch with the changes made from the current solution.
Deploy a full copy of the new solution with the changes using the upgrade option.
Deploy a full copy of the current solution with the changes using the upgrade aption.

Deployment option for automation enhancements

Deploy the new solution and then deploy a full copy of the onginal solution. Use the upgrade option for both deployments,
Deploy a full copy of the original solution and then deploy the new solution. Use the upgrade option for both deployments.
Deploy a full copy of the oniginal selution using the upgrade option. Then, deploy the new solution by using the update option.

A. Mastered
B. Not Mastered

Answer: A
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Explanation:

Box 1: Deploy a patch with the changes made from the current solution. Scenario:

The Onsite Visit managed solution has a table that is not in the Verification Process Automation managed solution. This table must be upgraded prior to the go-live
date without the other shared components.

Box 2: Deploy a full copy of the original solution using the upgrade option. Then, deploy the new solution by using the update option.

Scenario: All components required for the verification process must be included in a new solution. Corporate security requires that deployments to non-
development environments must be automated using

service accounts.

Managed solutions are used to move customizations from the development environment to other higher-level environments. These solutions are created and
maintained by the power users and provided to internal IT for deployment when they are ready.

Note:

Upgrade This is the default option and upgrades your solution to the latest version and rolls up all previous patches in one step. Any components associated to the
previous solution version that are not in the newer solution version will be deleted. This is the recommended option as it will ensure that your resulting configuration
state is consistent with the importing solution including removal of components that are no longer part of the solution.

Update This option replaces your solution with this version. Components that are not in the newer solution won't be deleted and will remain in the system. This
option is not recommended as your destination environment will differ in configuration from your source environment and could cause issues that are difficult to
reproduce and diagnose.

Reference: https://docs.microsoft.com/en-us/power-apps/maker/data-platform/update-solutions

NEW QUESTION 9

- (Exam Topic 2)

You need to configure a Power Automate flow to send the email with the results to the client. What should you use? To answer, select the appropriate options in
the answer area.

NOTE: Each correct selection is worth one point.

Trigger settings

Set Table name to Qualification and Column filter to statecode.
Set Table name to Qualification and Column filter to statuscode.
Set Table name to Service Requests and Column fiiter to statuscode.

Logic to complete service requests

Complete if current record is in Complete status.
Compiete if current record is in Pending Verification status.
Loop through related qualification records and complete if all are in Complete status.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Box 1: Set Table table to Qualification and Column filter to statuscode.

Box 2: Loop through related qualification records and complete if all are in Complete status. The new process for completing a service request must automate the
following:

Set the Service Request record status to Complete when work on all Qualification records is finished.

Send an email to the client with the results when the service request is completed. The email must list each qualification as either Valid or Not Valid, depending on
the verification.

NEW QUESTION 10

- (Exam Topic 2)

You need to resolve the issue reported by substitute employees after they are assigned service requests. How should you configure the system? To answer, select
the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
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Aspect Configuration

Relationship v

‘Service Request 1:N Qualification
‘Service Request N:N Qualification
Service Request N:1 Qualification

Cascading rule v

Restrict
‘Cascade All
Cascade None

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Box 1: Service Request 1:N Qualification

When users go on vacation, all their outstanding Service Request records are assigned to a substitute employee. The substitute employees are unable to see all
the qualifications related to their service requests.

Box 2: Cascade All

Cascade All - Perform the action on all referencing table records associated with the referenced table record. Reference:
https://docs.microsoft.com/en-us/power-apps/developer/data-platform/configure-entity-relationship-cascading-b

NEW QUESTION 10

- (Exam Topic 2)

You need to assign 10 percent of the Qualification records to the QV queue through table configuration by using a Power Automate flow.
What should you do?

A. Create an autonumber column on the Qualification table and assign its qualification records if the number cleanly divides by 10.

B. Create a calculated column on the Service Request table that sums the number of qualification records, generates a random number between zero and the
number from the new field, and assigns each qualification record if the number generated is 10 percent or less of the value of the new field.

C. Create a roll-up column on the Service Request table that is the count of qualification records, generates a random number between zero and the number from
the new field, and assigns each qualification record if the number generated is 10 percent or less of the value of the new field.

D. Create an autonumber column on the Service Request table and assign its qualification records if the number cleanly divides by 10.

Answer: B

NEW QUESTION 12

- (Exam Topic 2)

You need to be able to move a Power Automate desktop flow used in the verification process to the testing environment.
What should you do?

A. Share a copy of the desktop flow with a member of internal IT.

B. Use the Export option in the flow to get the flow identifier and provide it to internal IT.
C. Send a copy of the desktop flow to a member of internal IT.

D. Create the desktop flow in a solution and provide it to internal IT.

Answer: D

Explanation:

Internal IT reports that the solution import to the test environment failed because of missing dependencies related to the flow for completing service requests.
Flows with PowerApps steps

Flows that were created via Power Automate in the PowerApps menu or flows that have PowerApps steps added have a different issue then other Power
Automate flows. As of the writing of this blog these flows are not able to be imported into another environment. This means that if you create flows with Power
Apps steps within them you will need to recreate them in your destination environment.

Reference: https://www.spyglassmtg.com/blog/power-platform-solution-export-and-import-issues

NEW QUESTION 13

- (Exam Topic 3)

You are a Dynamics 365 Customer Service system administrator.

Your organization does not permit the use of custom code for solutions. You need to create a view that can be viewed by all users in an organization. Where
should you create the view?

A. Microsoft Excel template
B. Entities component of a solution
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C. Microsoft Virtual Studio
D. Templates area

Answer: B

Explanation:
Entity: Refers to a table in Dataverse. Table and entity are often used interchangeably for data access. Edit public views through tables

> Expand Data, select Tables, select the table you want, and then select the Views area.
> On the toolbar, select Add view. Add view to table

> On the Create a view dialog, enter a name and, optionally, a description, and then select Create. Reference:
https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/create-edit-views-app-designer

NEW QUESTION 17

- (Exam Topic 3)

You create a parent entity and a child entity. The parent entity has a 1:N relationship with the child entity.

You need to ensure that when the owner changes on the parent record that all child records are assigned to the new owner.
You need to configure the relationship behavior type. What should you use?

A. Parental

B. Referential, Restrict Delete
C. Referential

D. Restrict

Answer: A

Explanation:

https://docs.microsoft.com/en-us/dynamics365/customer-engagement/customize/create-and-edit-1n-relationship A parental table relationship is any 1:N table
relationship where one of the cascading options in the Parental column of the following table is true.

Graphical user interface, application Description automatically generated

Action Parental Mot Parental
Assign _ascade A _ascade Mone
cCade nad
-ascade Active
Deletee @™ = Cascad 2 Al Remn el
Reparent _ascade All Cascade Mone
ascade User f
ssCade i  —
Share —ascade All Cascade None
Cac o 1 o
_ascade Active
Unshare _ascade Al Cascade None

3
J'

Reference:
https://docs.microsoft.com/en-us/powerapps/maker/data-platform/create-edit-entity-relationships

NEW QUESTION 20
- (Exam Topic 3)
You plan to create classic workflows for process automation on the Account table. The process automation has the following requirements:
« If the Account Name column changes, a custom column named Previous Name must be updated with the original value.
« If the Credit Limit column changes, an email must be sent to the record owner with the new value.
» Asynchronous processes must be used whenever possible. You need to implement the process automation.
What is the minimum number of workflows you should use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.
Answer Area

Workflow type Number of workflows

Background

Real-time

-
-
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A. Mastered
B. Not Mastered

Answer: A

Explanation:
Answer Area

Workflow type Number of workflows

Background

-
- - - -
Feal-time -

NEW QUESTION 24
- (Exam Topic 3)
You create a canvas app that uses data from a Microsoft SQL Server database.
You use a dataflow to move some of the data from the database to Microsoft Dataverse. Users will filter the data by using the app.
You need to filter data in the dataflow and in the canvas app.
Which tools should you use? To answer, drag the appropriate tools to the correct requirements. Each tool may be used once, more than once, or not at all. You
may need to drag the split bar between panes or scroll to view content.
Tools Answer Arca

. £ 2
Power Fx Requirement Tool
Power Query Filter data in the datafiow

Filter data in the canvas app

A. Mastered
B. Not Mastered

Answer: A

Explanation:

First Box: Power Query

To filter data in a dataflow, you should use Power Query. Power Query is a data connection tool that is part of the Microsoft Power Platform, which allows you to
connect to various data sources, transform, and load data into other applications such as Power Bl, Excel, and Dataverse. It is a functional, case-sensitive, and
data-transformation language that enables you to discover, connect, combine, and refine data sources to meet your business intelligence needs.

Power Query allows you to filter data by using its built-in functions and operators. You can filter data by using the filter, sort, and group by functions, as well as by
using custom formulas and conditions. You can also use the advanced editor to write complex queries using M code, which is the underlying language used by
Power Query.

Reference: https://docs.microsoft.com/en-us/power-query/ https://docs.microsoft.com/en-us/power-query/transform/filter-rows-by-condition

2nd Box: Power Fx

To filter data in a canvas app, you should use Power Fx. Power Fx is a no-code, low-code, and code-based platform that enables you to build custom business
logic and automate workflows in your Power Platform apps. It allows you to create custom formulas and expressions in the app using a functional language, which
allows you to filter data in the app.

Power Fx can be used to create custom formulas and expressions in the app which can filter data in the app by using its built-in functions and operators. You can
filter data by using the filter, sort, and group by functions, as well as by using custom formulas and conditions. You can also use the advanced editor to write
complex queries using Power Fx code.

Reference: https://docs.microsoft.com/en-us/power-apps/maker/canvas-apps/power-fx-formulas

NEW QUESTION 25

- (Exam Topic 3)

You are creating tables for use with Microsoft Power components.

The display names of the tables must not be changed when the solution is promoted to the user acceptance testing environment.
You need to apply this restriction to the solution, Where should you make the changes?

A. Power Apps

B. Default solution

C. Segmented solution
D. Unmanaged solution
E. Managed solution

Answer: C
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NEW QUESTION 30

- (Exam Topic 3)

You are designing a desktop user interface (Ul) flow. The Ul flow automates legacy software.

You need to prepare data for transfer to a Microsoft SharePoint list.

Which four actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

Actions Answer Area
Select information to pass to the SharePoint list.

Copy and paste the text in the output definition window

On the Qutputs menu of the Ul flow, choose Select @
text on screen. @

Qe

Enter a name and description for the output.

otart recording the Ul flow.

Stop the recording and save the flow

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Reference:
https://docs.microsoft.com/en-us/power-automate/ui-flows/inputs-outputs-desktop#use-outputs-to-extract-inform

NEW QUESTION 35

- (Exam Topic 3)

You are a Dynamics Sales administrator for a car dealership. The dealership uses only out-of-the-box functionality. When a new car is sold, the salesperson uses
a Word template to generate a letter from the quote to thank the customer.

You need to determine if you can revise the template. Which Word template change can you make?

A. Add the Discount field conditionally.

B. Format the table to have alternating color rows.

C. Format the Created On field to a long date format.

D. Add the address of the customer.D18912E1457D5D1DDCBD40AB3BF70D5D

Answer: D

NEW QUESTION 39

- (Exam Topic 3)

You are a Dynamics 365 Customer Service developer. A salesperson creates a chart.

You need to ensure that the chart is available to all users on the team. What should you do?

A. Share the chart with the team.

B. Assign the chart to each person on the team.
C. Export the user chart to Power B

D. Import the chart as a Power BE visualization.
E. Export the user chart for import as a user chart.

Answer: A

NEW QUESTION 40

- (Exam Topic 3)

You are developing a canvas app.

You need to apply business rules to the app without writing code.

Which three actions can you use? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. Validate data and show error messages.B Enable or disable fields.
B. Set field requirement levels.

C. Set field values.

D. Show or hide fields

Answer: ACD
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Explanation:
The following actions are not available on Canvas apps:

5\"' Show or hide columns
;" Enable or disable columns

> Create business recommendations based on business intelligence Reference:
https://docs.microsoft.com/en-us/powerapps/maker/data-platform/data-platform-create-business-rule

NEW QUESTION 41

- (Exam Topic 3)

A company plans to implement a voice-enabled Power Virtual Agents bot. The company has the following requirements for the bot:
» Recognize when a caller states Tennis or any variation of the word.

* Provide options when a caller states the name of a sport. You need to configure the bot.

Answer Area
Requirement Feature
Recognize when caller states Tennis | Entity v |
Provide options when caller states name of _
sport OPIC
‘l;.*rll:'-!:'lf"'
Provide options when caller states name of Topic hd
spor Entity
Var :.ft !w
A. Mastered
B. Not Mastered
Answer: A
Explanation:
Answer Area
Requirement Feature
Recognize when caller st1ates Tennis | Entity v |
Provide options when caller states name of _
sport o] ls
Vanable
Provide options when caller states name of lopic >
sport

NEW QUESTION 43

- (Exam Topic 3)

A company creates a Microsoft Power Apps app through the Power Apps designer portal for use in Microsoft Teams.

This app needs to be promoted to the user acceptance testing environment.

You need to complete the Microsoft recommended actions before you export the solution. Which two actions should you complete? Each correct answer presents
part of the solution. NOTE: Each correct selection is worth one point.

A. Write validation tests.

B. Set the Optimized embedding appearance field to true.
C. Publish all changes.

D. Run the solution checker.

E. Clone a solution.

Answer: DE

Explanation:

The Power Apps solution checker performs a rich static analysis check on your solutions against a set of best practice rules to quickly identify problematic patterns.
After the check completes, you receive a detailed report that lists the issues identified, the components and code affected, and links to documentation that
describes how to resolve each issue.

The solution checker analyzes these solution components: Common Data Service plug-ins

Common Data Service custom workflow activities

Common Data Service web resources (HTML and JavaScript) Common Data Service configurations, such as SDK message steps

Reference: https://www.eimagine.com/ui/
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NEW QUESTION 44

- (Exam Topic 3)

You are a Dynamics 365 Sales administrator for a software company. The sales team wants to attach a large number of supporting documents to customer
records, but management does not want to incur the cost of additional storage.

The company does not have any Office 365 application integrations enabled. You need to recommend a storage solution that keeps storage costs low. Solution:
Enable Outlook integration

Does the solution meet the goal?

A. Yes
B. No

Answer: B

Explanation:
Instead enable server-based SharePoint integration. Reference:
https://docs.microsoft.com/en-us/power-platform/admin/set-up-dynamics-365-online-to-use-sharepoint-online

NEW QUESTION 46

- (Exam Topic 3)

A company deploys several model-driven apps. The company uses shared devices in their warehouse. The devices are always powered on. Users log on to the
devices and then launch the apps to perform actions.

Unauthorized users recently uploaded several files after another user failed to log out of a device. The company needs to prevent these incidents from occurring in
the future.

You need to configure the solution to prevent the reported security incidents. What should you do? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Requirement Action
Prevent unauthonzed access to devices b
Set an inactivity limit in the user's group policy
Set a timeout in the Power Platform admin center
Configure access controls in Azure Active Directory
Confiqure a Power Automate flow to poll for user inactivity on the devices. |

Prevent users from uploading a specific type of file. v

Enter the restricted file types in the SharePoint admin center
Enter the allowed file types in the Power Platform admin center.

Enter the restricted file types in the Power Platform admin center

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Graphical user interface, text, application Description automatically generated

Box 1: Set a timeout in the Power Platform admin center.

To enforce users to reauthenticate after a pre-determined period of time, admins can set a session timeout for their individual environments. Users can only remain
signed in the application for the duration of session. The application signs out the user when the session expires. Users need to sign in with their credentials to
return to customer engagement apps.

Note: Configure session timeout

> In the Power Platform admin center, select an environment.
> Select Settings > Product > Privacy + Security.

> Set Session Expiration and Inactivity timeout. These settings apply to all users.
Incorrect:
Configure inactivity timeout

> In the Power Platform admin center, select an environment.
> Select Settings > Product > Privacy + Security.

> Set Session Expiration and Inactivity timeout. These settings apply to all users. Box 2: Enter the restricted file types in the SharePoint admin center.
To block uploading of specific file types

> Go to the Settings page of the new SharePoint admin center,

> Select Sync.
Graphical user interface, text, application Description automatically generated
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Sync

> Select the Block upload of specific file types check box.
> Enter the file name extensions you want to block, for example: exe or mp3.

> Select Save.
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/user-session-management https://docs.microsoft.com/en-us/onedrive/block-file-types

NEW QUESTION 47

- (Exam Topic 3)

You create a Power Apps app for Microsoft Teams using Microsoft Dataverse for Teams. Users report that they are unable to view the app in Teams. You need to
ensure that users can access the app. What should you do?

A. Share the app with a security group by using the Maker portal.

B. Share the app with a security group in Teams.

C. Request that a tenant administrator pin the app to the app bar in Teams.
D. Publish the app by using the Maker portal.

E. Share the app with individual users by using the Maker portal.

Answer: C

Explanation:
When you create a Power Apps app for Microsoft Teams using Microsoft Dataverse for Teams, the app needs to be added to the app bar in Teams before it can

be accessed by users. This can only be done by a tenant administrator. To ensure that users can access the app, you would need to request that the tenant
administrator pin the app to the app bar in Teams.

Sharing the app with a security group by using the Maker portal (A) or in Teams (B) would allow users in that group to access the app, but they would still need to
be able to find and open the app.

Here are some references from Microsoft that may be helpful in understanding how to make Power Apps app available in Teams:
> Microsoft docs: Add a Power Apps app to a Microsoft Teams channel

> Microsoft docs: Pin a Power Apps app to the app bar in Microsoft Teams

> Microsoft docs: Distribute Power Apps for Microsoft Teams

NEW QUESTION 49

- (Exam Topic 3)

You create a new Power Virtual Agents chatbot for an organization. Testing and production deployment of the chatbot are not complete. You need to ensure that
appropriate users can access the chatbot.

Which methods should you use? To answer, select the appropriate options in the answer area.

NOTE: Each correct selection is worth one point.

Answer Area
Requirement Method

Test the chatbot with unlicensed internal users v
Use the demo website
Share the chatbot to each user individually
Share the chatbot to a security group containing all users

Allew other licensed internal users to edit the chatbot v
Share the chatbot to each user individually
Share the chatbot to a security group confaining all users
Deploy the chatbot to Microsoft Teams in your tenant

Deploy the chatbot to production for public consumption v
Embed the chatbet code in an IFrame on your company's public website
Deploy the chatbot te Microsoft Teams in your tenant
Deploy the chatbot to AppSource

A. Mastered
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B. Not Mastered
Answer: A

Explanation:

Graphical user interface, application Description automatically generated

Box 1: Use the demo website

When publishing the bot to the web, you can publish to a prebuilt demo website (which you can use to share the bot with your teammates and stakeholders) and to
your own live website.

Box 2: Share the chatbot to a security group containing all users.

A license for each user, also known as a "per user license" (or "Power Virtual Agent User License" as referred

to on the Microsoft 365 admin center), should be assigned to individual users who need access to create and manage chatbots.

To simplify user license management, you can assign licenses to an Azure Active Directory (Azure AD) security group.

Box 3: Embed the chatbot code in an IFRame on your copany's public website

You can add your bot to a live website as an IFrame. Your live website can be a customer-facing external website or an internal site, like a SharePoint or Yammer
site.

Reference:

https://docs.microsoft.com/en-us/power-virtual-agents/publication-connect-bot-to-web-channels https://docs.microsoft.com/en-us/power-virtual-
agents/requirements-licensing

NEW QUESTION 53
- (Exam Topic 3)
A company plans to automate the following manual processes by using Power Automate. You need to identify Ul flow types for the two business processes.

P?ucess] Time to Complete Comments
30 minutes The user's device must remain unlocked when the business process runs. The user will be required to leave their
. device unattended in a secure setting while the business process runs so that the user can assist wath other
afforts
2 i 45 minutes The process must run after normal business hours, The device that runs the business process must remain
S _ _| unlocked when the business process 1s not unning. - = _ _ _ o’ _

Which desktop flow type should you use? To answer, drag the appropriate desktop flow types to the correct business processes. Each desktop flow type may be
used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

Desktop flow types Answer Area

{tended Inanended Business process Desktop flow type

aalimm Ml
L LiE%

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Graphical user interface, application Description automatically generated

NEW QUESTION 54

- (Exam Topic 3)

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You are creating Power Virtual Agents chatbot that captures demographic information about customers. The chatbot must determine the group a customer belongs
to based on their age. The age groups are:

> 0-17
> 18-25
> 26-35
> 36-55

> 55-100

You need to configure the chatbot to ask a question that can be used to determine the correct age group. Solution: Use Date and time for Identify in the question
and then add branches that use conditional logic to

determine the age group.

Does this meet the goal?

A. Yes
B. No
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Answer: B

NEW QUESTION 56

- (Exam Topic 3)

You deploy a Power Vitlu.il Agents chatoot that integrates with Dynamics 365 Omnichannel for Customer Service.

You observe that the chatbot is not able to recognize the questions asked by use's.

You need to ensure that the chatbot can respond to unrecognized questions. The solution must minimize administrative effort.
What should you do?

A. Add a fallback topic

B. Create new topics.

C. Create an entity.

D. Modify the Escalate system topic.

Answer: A

NEW QUESTION 59

- (Exam Topic 3)

A company is building a Power Virtual Agents chatbot.

Users in the accounting department require access to collaborate with the building of the bot. Users in the sales department require access to only chat with the
bot.

You need to configure the bot.

Which sharing options should you use? To answer, drag the appropriate sharing options to the correct requirements. Each sharing option may be used once, more
than once, or not at all. You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Sharing options Answer Area
YR Requirement Sharing option
e e Usérs in the accounting department
-y N ™ "~ I [ s "
i tRa S ) i i
A. Mastered
B. Not Mastered
Answer: A
Explanation:
Sharing options Answer Area
- Requirement Sharing option
the arcour ARACRER ' Active Directory secunty groups 1

NEW QUESTION 63

- (Exam Topic 3)

On a Contact record, a user creates a Note record that contains the word running.

One week later, the user reports that they cannot find the Contact record associated with the Note record. You need to find the Note record.
Solution: Use Relevance Search to search for the word run. Does the solution meet the goal?

A.Yes
B. No

Answer: A

Explanation:
Relevance Search brings the following benefits:

> Finds matches to any word in the search term in any field in the entity. Matches may include inflectional words, like "stream," "streaming," or "streamed."

> Includes the ability to search documents found in Notes and Attachments on Emails and Appointments Reference:
https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-organization#what-is-releva

NEW QUESTION 68

- (Exam Topic 3)

You create a new independent software vendor (ISV) solution for a Power Apps app.

The Power Apps solution will be imported into multiple customer environments. The environments will have a large variety of solutions and publishers.
You need to avoid naming conflicts during solution import.
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Which element should you configure?

A. Package type

B. Configuration page
C. Marketplace

D. Prefix

E. Version

Answer: D

Explanation:

A solution publisher includes a prefix. The publisher prefix is a mechanism to help avoid naming collisions. This allows for solutions from different publishers to be
installed in an environment with few conflicts. For example, the Contoso solution displayed here includes a solution publisher prefix of contoso.

Reference: https://docs.microsoft.com/en-us/power-platform/alm/solution-concepts-alm

NEW QUESTION 73

- (Exam Topic 3)

You are a system administrator for a company with locations in Mexico, United States, and France. The company has both fulltime employees and contractors in
all regions. Fulltime employees use a mobile app. The company has two security groups: fulltime employees and contractors.

The company requests a chatbot in Microsoft Teams to answer employee benefit questions. The chatbot must meet the following requirements:

* It must be in the local language.

* Only fulltime employees may access the chatbot. You need to configure the chatbot.

Which action should you perform? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
Answer Area

Requirement Configuration
Chatbot in local language Lreate one chathor that manages all three languages -
Create one chatbot that manages all three languag
Create one chatbot and add it 1o three Teams channels that are configured for the local language,
Create three chatbots, one for each language

EI“"IFJ!C:,'E'E' access Pubilish the chatbot in Teams -
Share the chatbol wath the fullime employees
Publish the chatbot 1o the mobile app channel.
Add the chatbot 10 Appsource
.FuL'-!-sh the chatbot in Teams,

A. Mastered
B. Not Mastered

Answer: A
Explanation:
Answer Area
Requirement Configuration
Chatbot in lecal language taalesiechacbol hat Danacee il b ol -

Create one chatbol that manages all three languages.
Lreate one chatbot and add i 1o thres Teams channais that are configured for the local language,

| Create three chatbots, one for each language.

Employee access Publich the rhathat in Teams
Share the chatbot with the fulltime employmes
Fublish the chatbat to the mobie app channel,
Add the chaitbot to Appsource
Publish the chatbot in Teams

NEW QUESTION 77

- (Exam Topic 3)

A company uses Power Apps. You enable auditing in Microsoft Dataverse. Users report the following issues when viewing the audit logs:
* Unable to view the read access audit logs.

* Unable to view the Account table audit logs. You need to troubleshoot the issues.

What are the causes of the issues? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
Answer Area

lssue Cause

Unable 10 vigw the réad aciess audn logs I Auditing s not enabled at the environment level .
Storage for the tenant is over capacny
Auditing 15 not enabled at the emaronment level.

Unable to view the Account table audit logs | Auditing 15 disabled at the table level i

Auditing 18 disabled at the app level

Auditing s disabled at the table lewel

Auditing for réad access 5 not enabled

A. Mastered
B. Not Mastered
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Answer: A

Explanation:
Answer Area

lssue Cause

= —_— ——

nable 10 view the read access audit logs | Auditing 13 not enabled 2t the ermaronment leve _.

rAT DAY

al= - A = - a5 - ~ry
Unable 1o view the Account table audit logs | Auditing it { thee table lew
Foo LUl R R LR AL e L
Ayditing 1% disabled at the app level

¥
- 4 | T # A

NEW QUESTION 80

- (Exam Topic 3)

You need to build a Power Bl dashboard for sales managers to track opportunities.

When a new sale closes that is greater than S1 million, a notification must pop up and an email must be sent to the leadership team.
You need to ensure the email is sent without editing the Microsoft Dataverse.

Which two elements should you configure? Each correct answer is part of the solution. NOTE: Each correct selection is worth one point.

A. alerts in Power BI

B. a calculated column in the Dataverse

C. a custom connector

D. a paginated report to save to Microsoft OneDrive
E. a Power Automate flow

Answer: AE

Explanation:

In order to build a Power Bl dashboard for sales managers to track opportunities and send notifications and emails when a new sale closes that is greater than S1
million, you should configure:

* A. alerts in Power Bl: You can set up alerts in Power Bl that will trigger when a specific condition is met. For example, you can set an alert to trigger when the
value of a specific field in the "Opportunities" table exceeds $1 million.

* E. a Power Automate flow: To send an email to the leadership team when an alert is triggered, you can create a Power Automate flow that is triggered by the
Power Bl alert. The flow can then use the "Send an email" action to send an email to the leadership team with the necessary information about the sale that
exceeded $1 million.

References:

> https://docs.microsoft.com/en-us/power-bi/transform-model/desktop-alerts
> https://docs.microsoft.com/en-us/power-platform/admin/alerts-overview

NEW QUESTION 81

- (Exam Topic 3)

You are creating a business rule to implement new business logic.

You must apply the business logic to a canvas app that has a single screen named Screenl. You need to configure the scope for the business rule.
Which scope should you use?

A. All Forms
B. Entity

C. Screenl
D. Global

Answer: B

Explanation:

Note: Some terminology has changed. Entity is now Table. If you're building a Canvas app, you must use table (entity) as the scope.
Reference:

https://docs.microsoft.com/en-us/powerapps/maker/common-data-service/data-platform-create-business-rule

NEW QUESTION 84

- (Exam Topic 3)

A company uses a model driven app.

The company needs to automatically update the Status column in real time. You need to configure this feature.
Solution: Create a workflow that has a Change Status step. Does the solution meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 89

- (Exam Topic 3)

A company has locations in the United States, Brazil, India. and Japan. The company conducts financial transactions in all of these regions.
Financial transactions in Brazil are going to stop, but the office will remain open.

Users must longer be able to create records associated with the Brazilian currency. Historical records must remain intact
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You need to configure Microsoft Dataverse to meet the requirement
What should you do?

A. Rename the Brazilian currency.

B. Delete the Brazilian currency record.

C. Disable the Brazilian language pack

D. Deactivate the Brazilian currency record.

Answer: D

Explanation:

You can't delete currencies that are in use by other records; you can only deactivate them. Deactivating currency records doesn't remove the currency information
stored in existing records, such as opportunities or orders. However, you won't be able to select the deactivated currency for new transactions.

Reference:

https://docs.microsoft.com/en-us/power-platform/admin/manage-transactions-with-multiple-currencies

NEW QUESTION 94

- (Exam Topic 3)

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You are creating Power Virtual Agents chatbot that captures demographic information about customers. The chatbot must determine the group a customer belongs
to based on their age. The age groups are:

> 0-17
> 18-25
> 26-35
> 36-55

> 55-100

You need to configure the chatbot to ask a question that can be used to determine the correct age group. Solution: Create a custom Age group entity and
synonyms for each individual age in the corresponding item.

Use Age group for Identify in the question.

Does this meet the goal?

A. Yes
B. No

Answer: A

NEW QUESTION 99

- (Exam Topic 3)

A company has a Power Apps app.

The app must meet the following requirements:

* Managers assign lead records to the sales department. A new phone call record must be created if a lead record has no activities.

» An email must be sent to the manager if the phone call record created is not completed after one day. A classic workflow must run when a lead record is
assigned.

You need to configure the check conditions for the workflow. NOTE: Each correct selection is worth one point.
Answer Area

Condition Value
sumber of actraties for new phone call record. ] L IT j
Process Activity Count
Duration for email sent 1o manager i Lead Created On + 1 Day - 1
1 Day
Lead Created On + 1 D
Lead Modified On + 1 Day
A. Mastered
B. Not Mastered
Answer: A
Explanation:
Answer Area
Condition Value
Mumber of activities for new phone call record J C ﬁ
Frocess Activity Count
Duration for email sent 1o manager i ead Created On o+ 7 Day "'"|
1 Day
Lead Created On + 1 Day |
Lead Meodified On + 1 Day
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NEW QUESTION 101

- (Exam Topic 3)

You are using a development environment to add a new column to a system table. You plan to move the changes to a test environment they are complete.

The changes must meet the following requirements:

* Must be clearly identified so that they are not confused with system components and components from other solutions.

» Must not affect any existing components in the test environment. You need to prepare a solution for deployment to the test environment.

Which four actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the

correct order.
ALTiond AR AP0 E

Q0

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Step 1: Create a new publisher Solution publisher

Every app and other solution components such as entities you create or any customization you make is part of a solution. Because every solution has a publisher,
you should create your own publisher rather than use the default. You specify the publisher when you create a solution.

Step 2: Create a new unmanaged solution and select the correct publisher unmanaged solution

Unmanaged solutions are used in development environments while you make changes to your application. Unmanaged solutions can be exported either as
unmanaged or managed. Exported unmanaged versions of your solutions should be checked into your source control system. Unmanaged solutions should be
considered your source for Microsoft Power Platform assets. When an unmanaged solution is deleted, only the solution container of any customizations included in
it is deleted. All the unmanaged customizations remain in effect and belong to the default solution.

Step 3: Add the table top the solution and add the new column. Step 4: Run the solution checker on the solution

Use solution checker to validate your model-driven apps in Power Apps.

Reference: https://docs.microsoft.com/en-us/power-platform/alm/solution-concepts-alm https://docs.microsoft.com/en-us/power-apps/maker/data-platform/use-
powerapps-checker

NEW QUESTION 102

- (Exam Topic 3)

On a Contact record, a user creates a Note record that contains the word running.

One week later, the user reports that they cannot find the Contact record associated with the Note record. You need to find the Note record.
Solution: Use Categorized Search to search for the word run. Does the solution meet the goal?

A.Yes
B. No

Answer: B

Explanation:

Instead use Relevance Search.

Note: Relevance Search finds matches to any word in the search term in any field in the entity. Matches may include inflectional words, like "stream,
or "streamed.”

Reference:

https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-organization#what-is-releva

streaming,”

NEW QUESTION 104

- (Exam Topic 3)

A company is creating a canvas app and a model-driven app to manage their customer accounts.

The canvas app requires a business rule to set the Business Type column to large if the customer size is greater than a specific currency value.

The model-driven app requires a business rule to recommend the account rating be re-evaluated when the account goes on credit hold for this app only.

You need to configure the scope for the business rules.

Which scope should you use? To answer, drag the appropriate scopes to the correct business rules. Each scope may be used once, more than once, or not at all.
You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Scopes Answer Area

All forms | Business rule Scope

Business Type column setting for customer size
Specific form

Account rating re-evaluation
Table

A. Mastered
B. Not Mastered
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Answer: A

Explanation:

Box 1: Table

The canvas app requires a business rule to set the Business Type column to large if the customer size is greater than a specific currency value.
Scope the business rule to Entity (Table). Box 2: Specific form

The model-driven app requires a business rule to recommend the account rating be re-evaluated when the account goes on credit hold for this app only.
For Model

The scope of the business rule determines which forms the business rule will be applied. You set the scope, according to the following:

If you select this item... The scope is set to...

Entity- The table and all forms for the table All Forms- All forms for the table

Specific form (account Main Form, for example) - Just that form

Reference: https://debajmecrm.com/business-rules-in-powerapps-canvas-apps/
https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/create-business-rules-recommendations

NEW QUESTION 106

- (Exam Topic 3)

You plan to create a canvas app.

The app must meet the following requirements:

» Send an email after a record is saved.

» Display the expiration column on a form if the creation date of the record is older than 90 days. You need to configure the app.
Which features should you use? To answer, select the appropriate options in the answer area.

Answer Area

Requirement Feature
Send an email I Power Automate flow - I
- CALC L L |
Connection
Caollection
Power Automate flow
Formula
Display the expiration column. Formula hd

Collection

| Connection
A. Mastered
B. Not Mastered

Answer: A

Explanation:
Answer Area

Requirement Feature

send an email. | Power Automate flow v ]
Connection

Collection

[ FOrmula

Collection

Display the expiration column.

Connection

NEW QUESTION 110

- (Exam Topic 3)

You have a canvas app.

The canvas app must store data in a variable that is available only to the current screen. You need to create the variable.

Which two functions should you use? Each correct answer presents a complete solution. NOTE: Each correct selection is worth one point.

A. Navigate

B. UpdateContext
C. Set

D. Collect

E. SaveData

Answer: BC

Explanation:
* B. UpdateContext function can be used to create a variable that is only available to the current screen. This function takes in an object that defines the variable
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and its initial value, and updates the context of the current screen with that variable. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/functions/function-updatecontext

* C. Set function can be used to assign a value to a variable. The Set function sets a variable to a specified value, which is useful when you need to update the
value of a variable. Reference:

https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/functions/function-set

NEW QUESTION 114

- (Exam Topic 3)

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You are a Dynamics 365 Sales administrator for a software company. The sales team wants to attach a large number of supporting documents to customer
records, but management does not want to incur the cost of additional storage.

The company does not have any Office 365 application integrations enabled. You need to recommend a storage solution that keeps storage costs low. Solution:
Enable OneDrive for Business.

Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 119
- (Exam Topic 3)
You are customizing a model-driven app for a company. You create a Theme template to ensure the company logo and colors are properly used within these

apps.
The theme must meet the following requirements:

> Updated to add the logo

> Downloaded by the makers to create the app

You need to configure the assets. To answer, drag the appropriate configurations to the correct requirements. Each configuration may be used once, more than
once, or not at all. You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Configurations Answer Arca
Edit the theme in System setfings and upload a jpg Requirement Configuration
IE: Update logo.
Replace an existing Ul iterm’s hexadeamal number.
Change model-driven app colors
Upload the theme elements as new web resources

Use the component library,

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Box 1: Upload the theme elements as new web resources.

Each type of icon is stored as a web resource. Create a web resource first and then set the icons to use them. Alternatively, you can add the icon by creating a
new web resource when you define the table properties.

Box 2: Replace an existing Ul item's hexadecimal number. Copy and alter the existing theme

The easiest and quickest way to create a new theme is to clone and alter an existing theme. Then save, preview, and publish it.

> Sign in to Power Apps, select Settings icon (upper right), and then select Advanced settings.
> Select Customizations, and then select Themes.
> Under All themes, select the theme you want to clone, such as the CRM Default Theme. Select Clone on the command bar.

> Replace an existing Ul item's hexadecimal number, such as the Title Text Color, with the hexadecimal value that represents the color you want.
For example, the CRM Default Theme was cloned and changed using mostly varying shades of green color. The following screenshots show the new colors for
navigation and highlighting. A custom logo was also added that will appear in the upper left corner of an app.
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THEME

Gentle Green Theme -=

Theme Name

Theme Narme "

MNavigation Bar

Lago Tooltip

Navigation Bar Fill Color
Mavigation Bar Shelf Fill Colos
Title Text Color

Main Color

.} o ™ e
Accent Lolor

Reference:

Gentle Green Theme

new_defaultliogo

WS Green

#415C55

#79ABOE

#358717

HES5R25(

#A40194

SRR

https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/create-themes-organization-branding

NEW QUESTION 124
- (Exam Topic 3)

You create a model-driven app for an automobile parts help desk.
A help desk agent uses a form to gather information about customers' automobiles in two custom tables. The names of the tables are Client and Automobile,

The form must prepopulate the following information about the customer from the client table:

* First name
» Last name

The agent must be able to type the following information about the automobile:

» Automobile make
» Automobile model
You need to implement the form.

What should you configure? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

Answer Area

A. Mastered
B. Not Mastered

Answer: A

Explanation:
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Requirement

Hrepopulate chent information

Enter automobile information

Configuration

I e J““”‘ : : .

Dataflow

Alternate key
Virtual table

Table g
Wi
Connector

Power Automate flow
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Answer Area

Requirement Configuration

enter automoDile InTormeaticn

NEW QUESTION 127

- (Exam Topic 3)

You plan to create a dataflow by using Power Query to transform the data. You observe that some cells display an error instead of the expected data. You need to
obtain more details about the errors. What should you do?

A. Select the row that includes the cell with the error.
B. Use the Flow Checker.

C. Select the cell with the error.

D. Use the App Checker.

E. Use the Advanced Editor.

Answer: C

Explanation:
When you select the cell with the error, a tooltip will appear with more details about the error. This will help you identify the cause of the error and take the
necessary steps to fix it.

NEW QUESTION 128

- (Exam Topic 3)

A company uses Power Apps with Microsoft Dataverse.

The company enables auditing on the Dataverse database. The company tenant reaches the maximum storage capacity.

You need to delete some auditing data.

Which three deletion options should you use? Each correct answer presents a complete solution. NOTE: Each correct selection is worth one point.

A. by table

B. by record

C. between two specified dates
D. by column

E. older than a specified date

Answer: ACE

Explanation:

* A. Deleting by table allows you to select specific tables in the Dataverse database for which you want to delete the auditing data. This can be done by going to
the Power Apps portal, navigating to the Data tab, and selecting the table for which you want to delete the auditing data. You can then select the specific auditing
data you want to delete and click the "Delete" button. This is useful if you want to only delete auditing data for specific tables and not for the entire database.
Reference:

https://docs.microsoft.com/en-us/power-platform/admin/data/data-management-auditing#delete-audit-logs

* C. Deleting between two specified dates allows you to select a range of dates within which the auditing data will be deleted. This can be done by going to the
Power Apps portal, navigating to the Data tab, and selecting the "Audit" option. From there, you can select the "Delete" button, and select the "Between two dates”
option. Then you can specify the start and end date for which you want to delete the auditing data. This is useful if you want to delete auditing data for a specific
time period and not for the entire database. Reference: https://docs.microsoft.com/en-us/power-platform/admin/data/data-management-auditing#delete-audit-logs
* E. Deleting older than a specified date allows you to select a specific date, and any data older than that date will be deleted. This can be done by going to the
Power Apps portal, navigating to the Data tab, and selecting the "Audit" option. From there, you can select the "Delete" button, and select the "Older than a
specified date" option. Then you can specify the date for which you want to delete the auditing data. This is useful if you want to delete auditing data that is older
than a certain date and not for the entire database. Reference: https://docs.microsoft.com/en-us/power-platform/admin/data/data-management-auditing#delete-
audit-logs

It's always good to have a backup of Data before deletion and also check the retention period of the data you want to delete.

NEW QUESTION 130

- (Exam Topic 3)

You use Power Bl Desktop to configure Power BI reports.

You need to create a canvas app that displays user account information and include the app in a Power BI
report.

Which three actions should you perform? Each correct answer presents part of the solution.

NOTE: Each correct selection is worth one point.

A. From the Power Apps Insert menu, add a Power Bl tile

B. From the Power Bl Desktop menu, insert a Power Apps visual and include the required fields in the Power Apps data
C. Publish the report to the Power BI service

D. Connect to Common Data Service from Power Bl Desktop
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Answer: BCD

Explanation:

Step 1 (B): Here’s how we embed PowerApps into a Power Bl report:

> Download and login to the Power Bl desktop application
> Click on (...) and select “Import from the marketplace.”

Step 2: Open Power BI desktop and use “Get data” to connect with the Common Data Service data source. Step 3: Publish the report to Power Bl service.

Reference:
https://purple.telstra.com/blog/powerbi-integration-with-powerapps

NEW QUESTION 134
- (Exam Topic 3)
A company uses Power Apps.

Users must be able to view only the address1 columns in the Account table.
You need to ensure other address columns are not visible to users when creating views and filters. What should you do?

A. Disable the Search option for the columns.

B. Create business rules to hide the other address columns.

C. Delete the other address columns from the table.

D. Use column-level security to remove read access to all users.

Answer: D
NEW QUESTION 135

- (Exam Topic 3)
A company creates a canvas app.

The app requires users to enter their social security number. The app should only display the last four digits when the user tabs to a different column.

You need to configure the app. Which option should you use?

A. Power Fx

B. Business rule

C. Business process flow
D. Power Bl DAX

Answer: A
NEW QUESTION 136

- (Exam Topic 3)
You implement an editable grid for the Account entity.

The business team provides the following list of features that they would like you to implement:

> Group by or sort columns in the current view.

> Configure a business rule to show an error message.
> Edit values in calculated fields.

> Edit the Address composite field.

> Use the editable grid on mobile phones.

Which actions can you perform? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

Action

Group by or sort columns in the current view

Configure a business rule to show an error message.

Edit values in calculated fields.

Edit the Address composite field

Use the editable grid on mobile phones

A. Mastered
B. Not Mastered

Answer: A
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Explanation:
Action Can be performed?
Group by or sort columns in the current view -
Yes |
No
Configure a business rule to show an error message. v
Yes,
No
Edit values in calculated fields. = = - v
| TES
No
Edit the Address composite field. ol
Yes
'No_
Use the editable grid on mobile phones il
L Yes
I No 1

NEW QUESTION 139

- (Exam Topic 3)

A company uses a model-driven app with Microsoft Dataverse in a single environment

The company requires a canvas app that includes the same data as the model-driven app. You need to create the canvas app.

Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the

correct order.
Actions Answer area

Sefect the Excel option

Segn into the Microsaft Power Platform admin portal, @ @
Sign into the Power Apps Maker portal

Salact the Dataverse cption, @ @

Select the data source and tabias 1o include m the canvas app and than save the
o

A. Mastered
B. Not Mastered

Answer: A
Explanation:
Actions Answer area
i'_ ______________________ r _____________________________
: |
| Sedect the u g
R i nier e R e R P gt ' Sign into the Power Apps Maker portal |

1_-:"‘4
& |
=
g1
51
5]
= |
=
=
-8
L__‘?‘i
=
#J
i
"
= |
|
3
A
o |
=1
=
s = |
&
al
=1
1
i
_I

! Sign into the Power Apps Maker portal @ : Select the Dataverse option [

——————————————————————————————  { ]| e cmcr s m s rccccccccc e rccararccea- i

1 Select the Dataversegption. i Select the data source and tables to include in the canvas app and then save the
. B B B e \ app

I5elect the data source and tables to inchude in the canvas app and Then Save e | e s s i e e o B
lapp i

NEW QUESTION 143
- (Exam Topic 3)
You plan to create a Power Virtual Agents bot. The bot must support single sign-on.

You need to publish the bot.
Which two locations should you use? Each correct answer presents a complete solution. NOTE: Each correct selection is worth one point.

A. Microsoft Teams

B. Mobile app developed for iOS and Android
C. Azure Bot Service channels

D. Website developed using pro developer tools

Answer: CD

Explanation:
* C. Azure Bot Service channels: You can configure a Power Virtual Agents bot as a channel in Azure Bot Service. Single sign-on can be configured for the bot
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using Azure Active Directory (AAD) and the OpenlID Connect protocol. This allows you to use your existing AAD users and groups to control access to your bot.

* D. Website developed using pro developer tools: You can embed a Power Virtual Agents bot on a website using the Web Chat control. Single sign-on can be
configured for the bot using Azure Active Directory (AAD) and the OpenlID Connect protocol. This allows you to use your existing AAD users and groups to control
access to your bot.

NEW QUESTION 144

- (Exam Topic 3)

You are designing a Power Virtual Agents chatbot.

You observe that the environment you plan to use does not appear as an option in the Power Virtual Agents user interface.
You need to ensure that you can create the chatbot in the environment that you want to use. What should you do?

A. Create an environment in a supported region.
B. Convert the environment to a sandbox environment.
C. Change the region for the environment.

Answer: A

Explanation:

The environment doesn't show up in the drop-down menu of Power Virtual Agents

Your environment might not show up in the drop-down menu due to one of the following:

The environment doesn't have a database created. To resolve this issue, go to admin.powerplatform.com to create a database in your environment.
The environment is created in an unsupported region.

Reference: https://docs.microsoft.com/en-us/power-virtual-agents/environments-first-run-experience

NEW QUESTION 147

- (Exam Topic 3)

A company uses Common Data Service to manage account and contact information. The company plans to use the Al Builder model to make key business
decision.

You need to integrate prebuilt Al Builder models with Power Automate.

Which models should you use? To answer, select the appropriate option the answer area. NOTE Each correct selection is worth one point.

Scenario Model

Extract specific text from a PDF document v
Text recognition model

Key phrase extraction model

Text recognmition model and key phrase extraction model

Determine the likelihood that customers will purchase v
additional products Sentiment analysis model

Category classification model

Entity extraction model

Prediction model

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Reference:

https://docs.microsoft.com/en-us/ai-builder/prebuilt-sentiment-analysis https://docs.microsoft.com/en-us/ai-builder/prebuilt-key-phrase
https://docs.microsoft.com/en-us/ai-builder/prebuilt-text-recognition

NEW QUESTION 148

- (Exam Topic 3)

You are a Dynamics 365 Customer Service system administrator. You create an app for the sales team. Members of the sales team cannot access the app.
You need to ensure that sales team members can access the app. Where should you configure app permissions?

A. Security Roles

B. Manage Roles

C. Dynamics administration center
D. Dynamics 365 home

Answer: B

Explanation:

References:

https://docs.microsoft.com/en-us/dynamics365/customer-engagement/customize/manage-access-apps-security-r Manage access to apps by using security roles.
You can choose what users see and access from the My Apps page or the Customer Engagement home page by giving app access to specific security roles.
Users will have access to apps based on the security roles they're assigned to.

* 1. Go to Settings > My Apps.

* 2. In the lower-right corner of the app tile you want to manage access for, select More options (...), and then select Manage Roles.

* 3. Enter the following in the Manage Roles dialog box:
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a) App URL Suffix

b) Roles

c) Select Save.

* 4, Refresh the My Apps page.

* 5. Go to the Apps Being Edited view, and publish the app again. Reference:
https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/customize/manage-access-app

NEW QUESTION 152

- (Exam Topic 3)

You plan to add a Power Apps app to Microsoft Teams.

A Microsoft Dataverse for Teams environment has not been provisioned. You need to create a Dataverse for Teams environment.
Which two actions can you perform? Each correct answer presents a complete solution.

NOTE: Each correct selection is worth one point.

A. Create a new environment in the Microsoft Power Platform Admin Center.
B. Create a new app in Teams.

C. Create an app permission policy in the Teams admin center.

D. Install an existing app in Teams.

Answer: BD

NEW QUESTION 155

- (Exam Topic 3)

You are designing a canvas app that connects to Common Data Service.

You need to configure the app to meet the requirements and ensure that the canvas app is available offline. What should you implement? To answer, select the
appropriate options in the answer area.

NOTE: Each correct selection is worth one point.

Requirement Function
Pass values from the current screen when v
maowi ﬂg to another screen Nawgate
Back
MovePrevious
Display data to a user when the app is -
offline LoadData
LoadDateOffline
ShowData
A. Mastered

B. Not Mastered
Answer: A

Explanation:
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/offline-apps

NEW QUESTION 160

- (Exam Topic 3)

You plan to create a Power Virtual Agents bot. The bot has the following requirements:

» Ensure that user responses are available to any topic.

» Recognize a list of words from spoken language of users. You need to configure the bot.

Which features should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
Answer Area

Requirement Feature
User responses are available to any topic !_ Global vaniable ]
Entity
Bot variable
Global vanable
Recognize a list of words from spoken | Entity w [
language. Topi
ey
Vanable

A. Mastered
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B. Not Mastered
Answer: A

Explanation:
Answer Area

Requirement Feature
User responses are available to any topic | Global vanable v |
Entity
Bot variable
- T :
Recognize a list of words from spoken ! Entity v ]:
langquage. Topi
ETI
Vanable

NEW QUESTION 161

- (Exam Topic 3)

A company uses a model-driven Power Apps app in a new environment. The base language is English. You need to configure French and Spanish.
Which configuration component should you use? To answer, select the appropriate options in the answer area.

NOTE: Each correct selection is worth one point.

Requirement Configuration component

Allow a language to be used within an organization.

Default language
Language collation
Language packs
LCID

Enable the languages. v

Browser
Environment
Power Apps app
Tenant

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Box 1: Language packs

Before users can start using a Language Pack to display a language, the Language Pack must be enabled in your organization.

Box 2: Environment Enable the language

These settings can be found in the Microsoft Power Platform admin center by going to Environments > [select an environment] > Settings > Product > Languages.
Reference: https://docs.microsoft.com/en-us/power-platform/admin/enable-languages

NEW QUESTION 164

- (Exam Topic 3)

You plan on implementing complex business logic in Microsoft Dataverse tables by using Power Automate flows.

You realize that the functionality required to implement the business logic is not available in a Power Automate flow.

The new business logic must work in multiple Dataverse tables. In addition, the operation must return a value after it finishes and must be able to run from an
existing Dataverse action.

You need to recommend the method to implement the missing logic. What should you recommend?

A. Scheduled workflow
B. Bound action

C. Custom API

D. Unbound action

Answer: D

Explanation:
https://docs.microsoft.com/en-us/power-automate/dataverse/bound-unbound https://docs.microsoft.com/en-us/power-apps/developer/data-platform/custom-api

NEW QUESTION 169
- (Exam Topic 3)
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You plan to create a canvas app.
The app requires a button on the data entry screen that users can select to send an email. You need to configure the app.
What should you create?

A. Business process flow

B. Azure Logic App

C. Power Automate cloud flow
D. Classic workflow

Answer: C

NEW QUESTION 171

- (Exam Topic 3)

You are designing a Power Virtual Agents chatbot.

The chatbot must be able to maintain customer information if the conversation topic changes during a dialog.

You need to configure variables to store customer name and email address. Which type of variable should you create?

A. session
B. topic
C. bot

D. slot

Answer: C

Explanation:

By default, a variable's value can only be used in the topic where this variable gets created. However, you might want the bot to use the same value across topics.
This means the bot can remember the necessary context when a conversation spans multiple topics. In some systems, these types of variables are known as
global variables. In Power Virtual Agents, these variables are called bot variables, because they apply across the entire bot.

Reference:

https://docs.microsoft.com/en-us/power-virtual-agents/authoring-variables-bot

NEW QUESTION 174

- (Exam Topic 3)

You add a business process flow to the Account table. The flow has three stages. You need to ensure that a workflow can run when a user completes the final
stage. Which option should you use?

A. Start when: Record status changes

B. Available to run: Run this workflow in the background
C. Available to run: As an on-demand process

D. Available to run: As a child process

Answer: C

Explanation:

You can trigger on-demand workflows from inside a business process flow. For example, you can add an on-demand workflow to a business process flow so that
an activity, such as a task or email, is created whenever a stage is completed.

Note: A workflow becomes activated based on where you drop the workflow onto the business process flow designer.

On-demand stage processes. When the workflow is dropped onto a business process flow stage, the workflow is triggered on entry or exit of the stage.
Reference:

https://docs.microsoft.com/en-us/power-automate/bpf-add-on-demand-workflow

NEW QUESTION 178

- (Exam Topic 3)

You create a Power Virtual Agents chatbot to reduce the number of incoming support calls that require a live person.

The chatbot does not direct users to the correct information. You determine that this is because the chatbot is not able to identify which product a user is referring
to in a conversation.

You need to present a list of products so that users can select the correct product. What should you create?

A. Table

B. Variable
C. Slot filling
D. Entity

Answer: C

Explanation:

Slot filling is a natural language understanding concept that means saving an extracted entity to an object. However, in Power Virtual Agents, slot filling means
placing the extracted entity value into a variable.

Reference: https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling

NEW QUESTION 179

- (Exam Topic 3)

You ate a Dynamics 365 Customer Engagement administrator. You create workflows to automate business processes. You need to configure a workflow to meet
the following requirements:

* Be triggered when a condition is met.

* Run immediately.

* Perform an action when a condition is met.

How should you configure the workflow? To answer, select the appropriate configuration in the answer area. NOTE: Each correct selection is worth one point.
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Answer Arca
Workflow Requirement Configuration Option

i
Ny

A. Mastered
B. Not Mastered

Answer: A

Explanation:

1) Be triggered when a condition is met - Subject contains data
2) Run Immediately - Configure the workflow to run now

3) Perform an action when a condition is met - send an email

NEW QUESTION 183

- (Exam Topic 3)

You create a Power Apps portal to provide training and documentation for students. Students create a profile on the portal and then select and pay for courses.
You plan to add free courses to the training portfolio. Free courses must be automatically available to all students when they sign in.

You need to assign default permissions to students. What should you do?

A. Create an entity for managing free course

B. Create a Students web role and set the Authenticated Users role option to tru

C. Create appropriate entity permissions to access the free course entity records and assign the entity permissions to the web role.

D. Create an entity for managing free course

E. Create entity permission records to provide access to entity records for free courses and assign the entity permissions to users when they register on the portal
for the first time.

F. Create a Students web role and set the Authenticated Users Role option to tru

G. Assign the web role to each registered user.

Answer: C

NEW QUESTION 187

- (Exam Topic 3)

A user has access to an existing Common Data Service database.

You need to ensure that the user can create canvas apps that consume data from Common Data Service. You must not grant permissions that are not required.
Which out-of-the-box security role should you assign to the user?

A. Environment Admin
B. System Customizer
C. Common Data Service User
D. Environment Maker

Answer: D

Explanation:

Reference:

https://docs.microsoft.com/en-us/power-platform/admin/database-security#predefined-security-roles https://docs.microsoft.com/en-us/powerapps/maker/canvas-
apps/data-platform-create-app

NEW QUESTION 192

- (Exam Topic 3)

A company plans to create a Power Virtual Agents chatbot. The bot has the following requirements:

» Prompt for a location of the customer and the call must be routed to a support agent for the location.

« Transfer support calls at each location to a support bot that uses the Bot Framework. You need to configure the bot.

Which components should you use? To answer, drag the appropriate components to the correct requirements. Each component may be used once, more than
once, or not at all. You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct select is worth one point.
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Components Answer Area

"_1r-'.r' FoTy
W B LIC

Requirement Component

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Components Answer Area

"""'I'-L' b Requirement Component

| I T
1 LS
RoLite 10 lacatior Pt J

Route 10 support bot Vanabies

NEW QUESTION 193

- (Exam Topic 3)

On a Contact record, a user creates a Note record that contains the word running.

One week later, the user reports that they cannot find the Contact record associated with the Note record. You need to find the Note record.
Solution: Use Quick Find search on the Notes list to search for the word run. Does the solution meet the goal?

A. Yes
B. No

Answer: B

Explanation:

Instead use Relevance Search.

Note: Relevance Search finds matches to any word in the search term in any field in the entity. Matches may include inflectional words, like "stream," "streaming,”
or "streamed.”

Reference:

https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-organization#what-is-releva

NEW QUESTION 197

- (Exam Topic 3)

You have a canvas app that contains the following text input fields: 1d, FirstName, LastName. The app also has a button named Buttonl.

The OnSelect property for Buttonl1 contains the following expression: Collect(People, {Id:Id.Text, FirstName:FirstName.Text, LastName:LastName.Text})
For each of the following statements, select Yes if the statement is true. Otherwise, select No.

NOTE: Each correct selection is worth one point.

Statement Yes No
The Penple collection is aummaticaily created if it does not already exist. O O
When Button1 is pl’ESSEd, if a record with the current value of Id. Text
EFI‘EEId}f gxists in the PEDPFE collection, the values for FirstName and O {:}

LastName are updated.

If you update the record in the Collection function to iclude the value from
a new field named Age, it will result in an error. O O

A. Mastered
B. Not Mastered

Answer: A
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Explanation:

Graphical user interface, text, application, email Description automatically generated
Box 1: Yes

If the data source doesn't already exist, a collection is created. Box 2: No

Note: The Collect function adds records to a data source. The items to be added can be:

> A single value: The value is placed in the Value field of a new record. All other properties are left blank.
> A record: Each named property is placed in the corresponding property of a new record. All other properties are left blank.

> A table: Each record of the table is added as a separate record of the data source as described above. The table isn't added as a nested table to a record. To
do this, wrap the table in a record first.

Box 3: No Reference:

https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/functions/function-clear-collect-clearcollect

NEW QUESTION 201

- (Exam Topic 3)

A company uses a model-driven app. The app uses a Power Virtual Agents chatbot.

The company has two locations in different countries/regions with separate environments for each location. Each location has a development environment, a
testing environment, and a production environment. The company uses the Application Lifecycle Management (ALM) process for the environments.

You need to create the different Power Virtual Agents bot environments. How many Power Virtual Agents bot environments are required?

00w
OO wWN PP

Answer: D

Explanation:

When a company uses a model-driven app that incorporates a Power Virtual Agents chatbot, and has multiple locations with different environments for each
location, it is necessary to create separate Power Virtual Agents bot environments for each location.

For each location, 3 different environments are required: development, testing, and production. This is in line with the Application Lifecycle Management (ALM)
process that the company uses.

In total, 6 Power Virtual Agents bot environments are required: 2 locations x 3 environments per location = 6. It's worth mentioning that Power Virtual Agents allows
to export and import the bot, so once you configure the bot in one environment, you can import the bot to the other environments, this way you don't need to start
from scratch.

References:

> https://docs.microsoft.com/en-us/power-virtual-agents/create-bot/bot-lifecycle
> https://docs.microsoft.com/en-us/power-virtual-agents/create-bot/export-import

NEW QUESTION 205

- (Exam Topic 3)

You have a form that displays a custom field from an entity.

A customer wants to restrict users from filtering on the custom field. You need to prevent users from filtering the field in Advanced Find. What should you modify?

A. Fields in the Edit Filter Criteria option of the Quick Find view
B. the Field Security field on the Field Properties form

C. a searchabile field on the Field Properties form

D. Fields in the Add Find Columns option of the Quick Find view

Answer: C

Explanation:
Reference:
https://community.dynamics.com/365/b/dynamics365apps/posts/kb-understanding-dynamics-365-field-ssearcha

NEW QUESTION 207

- (Exam Topic 3)

You plan to create a Power Bi dataflow.

The Power Bl dataflow has the following requirements:

« Be able to create a copy of the dataflow to separate Power Bl workspaces

» Schedule the dataflow to update every day at 11:00 AW. You need to configure the dataflow.

What should you do? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
Answer Area

Requirement Actien

3 = F ETE;
<Oy FOWET B Gataliow

SCnedune upoates

‘hange the properhe
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A. Mastered
B. Not Mastered

Answer: A

Explanation:
Answer Area

Requirement

Lopy Power Bl datatiow

Schedule upoates

nange the setiing

_hange the properties

Add Streaming dataset

Schedule updates | Configure the Power Bl service - |

Refresh the haston

Share the dashboards with other users

mefresh autaomancally

NEW QUESTION 209

- (Exam Topic 3)

A company deploys a chatbot that is embedded in a Power Pages website. The company has the following requirements for the chatbot:
» Azure AD users only must be able to use the chatbot when accessing sensitive data.

» The chatbot must be accessible only from the Power Pages website. You need to recommend a solution that meets the requirements.
Which two options should you recommend? Each correct answer presents part of the solution.

NOTE: Each correct selection is worth one point.

A. Enable Manual authentication.

B. Set up a new channel for the chatbot.
C. Enable Only for Teams authentication.
D. Enable web channel security.

E. Configure a data loss prevention policy.

Answer: DE

NEW QUESTION 214

- (Exam Topic 3)

You have a Power Apps portal app that supports a sales community and a service community in the same environment. The only language configured in the
environment is English. The company wants to add support for two more languages.

The solution must meet the following requirements:

> Languages must be for both sales and service functions.
> The company logo and colors must be used and apply to all screens.

> Communities must be separate with different URLs and access lists.

You need to configure the solution.

What should you configure? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Requirement Configuration

Lanquages v
Create two portals, one for each community.

Create three portals, one for each language.

Create one portal and import translations.

Create six portals, one for each combination of language and community.

Company logo and colors \

Add themes.
Add web resources.
Add a portal header and footer

A. Mastered
B. Not Mastered

Answer: A
Explanation:

Box 1: Create two portals, one for each community Power Apps portal app languages
Box 2: Add themes

You can create a custom look and feel (a theme), for your app by making changes to the default colors and visual elements provided in the uncustomized system.
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For example, you can create your personal product branding by adding a company logo and providing table-specific coloring. A theme can be created by using the
Themes area, without requiring a developer to write code. You can create, clone, change, or delete themes that are used in your environment.

Reference:

https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/create-themes-organization-branding

NEW QUESTION 217

- (Exam Topic 3)

You create functionality for a company. The functionality includes a Microsoft Dataverse table with a form for data entry. The functionality will be distributed to other
lines of business in the company, each with its own Dataverse environment.

New forms must not be created in order for updates to the functionality to work correctly. You need to package the new functionality for distribution.

What should you do?

A. Use a patch solution and disable the ability to create new forms for the table.

B. Use a managed solution and include only the needed form.

C. Use an unmanaged solution and include only the needed form.

D. Use a managed solution and disable the ability to create new forms for the table.

Answer: B

Explanation:

Managed solutions are used to deploy to any environment that isn't a development environment for that solution. This includes test, UAT, SIT, and production
environments. Managed solutions can be serviced independently from other managed solutions in an environment. As an ALM best practice, managed solutions
should be generated by exporting an unmanaged solution as managed and considered a build artifact. Additionally:

You can't edit components directly within a managed solution.

Reference: https://docs.microsoft.com/en-us/power-platform/alm/solution-concepts-alm

NEW QUESTION 220

- (Exam Topic 3)

You are a Dynamics 365 Customer Services administrator. You have a Production instance and Sandbox instance.

Users record Production instance data in the Sandbox instance.

You need to ensure that the users only record data in the Production instance.

Which security function needs to be edited to prevent access to the Sandbox? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Application area Security function
Microsoft 365 admin center v
Roles
Groups
Licenses
Access rights

Dynamics 365 Sandbox instance v
Roles

Groups

Access rights

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/control-user-access

NEW QUESTION 222

- (Exam Topic 3)

A customer tracks events by using a custom entity.

The custom entity includes a custom field for the venue of the events. The customer must be able to display the events by venue in a calendar.
You need to ensure that all events display by venue in the calendar. To which component should you add a control?

A. Form
B. view
C. Field
D. Chart

Answer: B

Explanation:
If you use unified interface, you can display any record in a calendar view via the calendar control.
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> Go to Settings->Customization->Customize the System

> Open the configuration for the entity that you want to use the calendar control (Opportunities in our example)
> Click the View tab

> Click “Add Control” and select the calendar control.

> Click the dot for every interface from which you want the calendar control to be available.
Reference:
https://crmtipoftheday.com/1206/view-any-dynamics-365-record-on-a-calendar/

NEW QUESTION 227

- (Exam Topic 3)

You are designing an app for a bank.

You must create entities for the app and configure relationships between entities:

Entity Requirements
This entity represents a I:,'Il_-l'_\- i .'.i'u:_'- 15 ApPPRVING far a 104an -i'll;_' entity must
LoanApplicant contain an attribute named Email. This attribute must provide look-up for
the name of the applicant
This entity represents a loan application. Loan applicants may apply for
Loan one loan per application. Loan applicants may have more than one active
apphcation
Froperty This entity represents the property that the applicant intends to purchase

Which relationship types should you use? To answer, drag the appropriate relationship types to the correct requirements. Each relationship type may be used

once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

Relationship types Answer Area

1N Requirement Relationship type
The email attribute of the Loan Applicant entity must

NN _ g
provide a look-up to the contact name and email.

N:1 Loan applicants can apply for one type of loan per
application. Applicants can have more than one application.
Loans must be applied for for a single property.

A. Mastered

B. Not Mastered
Answer: A

Explanation:

Text Description automatically generated

Box 1: N:1

You add a lookup column with a many-to-one relationship. Box 2: N:N

Box 3: N:1

Reference:
https://docs.microsoft.com/en-us/powerapps/maker/data-platform/data-platform-entity-lookup

NEW QUESTION 231

- (Exam Topic 3)

A company creates a bot by using Power Virtual Agents.

The company requires the bot to transfer callers to an agent if the bot is unable to recognize a customers request.
You need to configure the bot for the unrecognized information from the customer. Which feature should you use?

A. Fallback workstream
B. Fallback topic

C. Fallback skill

D. Fallback queue

E. Fallback entity

Answer: B

Explanation:

A Fallback topic is a type of topic in Power Virtual Agents that is used when the bot is unable to understand the customer's request. When a Fallback topic is
triggered, it takes over the conversation and presents the customer with a set of options or a message that allows them to get the help they need. This can include
options such as requesting to speak with an agent, providing feedback, or getting more information about the bot's capabilities. Fallback topic can be configured to

automatically transfer the customer to an agent.
References:

> https://docs.microsoft.com/en-us/power-virtual-agents/create-bot/fallback
> https://docs.microsoft.com/en-us/power-virtual-agents/create-bot/bot-topics
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NEW QUESTION 235

- (Exam Topic 3)

You must create a new entity to support a new feature for an app. Entity data will be transactional and will be associated with business units.
You need to configure entity ownership. Which entity ownership type should you use?

A. user or team owned
B. organization-owned
C. none

D. business-owned

Answer: A

NEW QUESTION 236

- (Exam Topic 3)

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it As a result, these questions will not appear in the review screen.

On a Contact record, a user creates a Note record that contains the word running.

One week later, the user reports that they cannot find the Contact record associated with the Note record. You need to find the Note record.

Solution: Use Datavserse Search to search for the word run. Does the solution meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 240

- (Exam Topic 3)

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You administer the Microsoft 365 and Power Platform environments for Contoso, Ltd. The company has a model-driven app that is used to track customer
interactions with employees. The app uses standard table types for customers. A user named Elisabeth Rice signs in to the app by using the following sign in
name: Elisabeth.Rice@contoso.com.

After marriage, Elisabeth changes her legal name to Elisabeth Mueller.

You need to update the sign in name for the user without losing any application history.

Solution: Delete the user account in the Power Platform admin portal and recreate the account by using the new name.

Does the solution meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 244

- (Exam Topic 3)

A company creates a canvas app.

The company plans to make the app available in Microsoft Teams. Only employees will be allowed to use the app.

You need to add the app to Teams.

Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

ok Ve By rea

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Bt Biepern Brpwenr grea

NEW QUESTION 246
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- (Exam Topic 3)

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You administer the Microsoft 365 and Power Platform environments for Contoso, Ltd. The company has a model-driven app that is used to track customer
interactions with employees. The app uses standard table types for customers. A user named Elisabeth Rice signs in to the app by using the following sign in
name: Elisabeth.Rice@contoso.com.

After marriage, Elisabeth changes her legal name to Elisabeth Mueller.

You need to update the sign in name for the user without losing any application history.

Solution: Ask the Microsoft 365 administrator to sign in to the admin portal and change the username. Does the solution meet the goal?

A. Yes
B. No

Answer: A

NEW QUESTION 249

- (Exam Topic 3)

You create and publish a Power Bl report that contains an embedded canvas app. The report will be used by multiple people.
The canvas app has an issue that must be corrected. You update the canvas app.

You need to ensure that the updated canvas app is available in the published Power Bl report. What should you do?

A. Publish the Power BI report from Power Bl Desktop.

B. Manually refresh the data source on the published Power BI report.

C. Publish the Power Bl report from Power Bl Desktop and reshare to any users.
D. Publish the canvas app.

Answer: B

Explanation:

> If you change the data fields associated with the visual, you must edit the app from within the Power BI service by selecting the ellipsis (...) and then selecting
Edit. Otherwise, the changes won't be propagated to Power Apps, and the app will behave in unexpected ways.

> The Power Apps visual can't trigger a refresh of Power Bl reports and Power Bl data sources from within Power Bl Desktop. If you write back data from the app
to the same data source as the report, your changes won't be reflected immediately in Power Bl Desktop. Changes are reflected on the next scheduled refresh.
Reference:

https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/powerapps-custom-visual#limitations-of-the-po

NEW QUESTION 254

- (Exam Topic 3)

A company has a model-driven app.

The app must meet the following requirements:

* Prevent users from saving a record if validation from a custom action fails.

* Query and update a list of records.

You need to configure processes for the app without using code.

Which processes should you use? To answer, drag the appropriate processes to the correct requirements. Each process may be used once, more than once, or
not at all. You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Processes Answer Area

™1 d Ao "

0L Tior Requirement Process
n] " s LT e )

assic workflow Prevent users from saving a record

Query and update reconds.

Business process fiow

A. Mastered

B. Not Mastered
Answer: A

Explanation:
Processes Answer Area

Requirement Process

Prevent users from saving a record

NEW QUESTION 255

- (Exam Topic 3)

You are setting up Power Apps security for a company. The company has a CEO, two vice presidents, and 10 managers. Five support representatives report to
each manager.

You set up Manager Hierarchy so managers are able to view data only for the representatives who report to them. The CEO must be able to view all data for
everyone. All support representatives must be able to view customer information in each other’s data across all managers.
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You need to resolve issues that arise during testing.
What should you do? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Issue

Managers are unable to view all their
report data.

The CEQ is unable to view
representative data but can view
manager data.

Five support representatives can view
only their own data.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Action

Add the manager's name to the representative’s user record.
Change the Manager Hierarchy depth to 2.

Move the manager and reports to a separate business unit
Set up a position in hierarchy.

Add the CEQ to the representative user record as a manager.
Change Manager Hierarchy depth to 3.
Create team security.

Add the manager's name to the representative's user record.
Add users to field security.
Set up a position hierarchy.

Box 1: Move the manager and reports to a separate business unit.

Keep the Manager hierarchy, and put the reports to the appropriate business unit.
Note: Two security models can be used for hierarchies, the Manager hierarchy and the Position hierarchy. With the Manager hierarchy, a manager must be within

the same business unit as the report, or in the parent business unit of the report’s business unit, to have access to the report’'s data. The Position hierarchy allows

data access across business units. If you are a financial organization, you may prefer the Manager hierarchy model, to prevent managers’ accessing data outside

of their business units. However, if you are a part of a customer service organization and want the managers to access service cases handled in different business
units, the Position hierarchy may work better for you.

Box 2: Add the CEO to the representative user record as a manager. Set up Manager and Position hierarchies
The Manager hierarchy is easily created by using the manager relationship on the system user record. You use the Manager (ParentsystemuserID) lookup field to

specify the manager of the user.

Note: Depth is used to limit how many levels deep a manager has Read-only access to the data of their reports. For example, if the depth is set to 2, the CEO can
see the data of the VP of Sales, VP of Service and Sales and Service Managers. However, the CEO doesn’t see the Sales data or the Support data.

Box 3: Add users to field security

Power Platform's field-level security lets you set which fields users can see or edit. Reference: https://docs.microsoft.com/en-us/power-platform/admin/hierarchy-
security https://docs.microsoft.com/en-us/power-platform/admin/field-level-security

NEW QUESTION 257
- (Exam Topic 3)

A company uses a model-driven app for customer support. The company has the following requirements for the app:

» Send an email in real-time to customers when they enter their email address.
» Send an email to customers at the same time every day for cases that are open for more than 24 hours. The solution should require the least amount of

customization.

You need to configure the model-driven app. Which components should you use?
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Components

Power Apps component framework
(PCF) control

| Classic workfiow

| Power Automate flow

| JavaSeript

A. Mastered
B. Not Mastered

Answer: A
Explanation:

Components

| Power Apps component framework I

| (PCF) control

T

| Classic workflow

- O S E S S W S

T e, e T O T O O . O .

'| Power Automate flow

o o e o S S e O S S e

NEW QUESTION 262
- (Exam Topic 3)

1

|

|
|

B i e S il

Answer Area

Requirement

Send email to customer when email
address entered,

Send email at the same time every day.

Requirement

Send email to customer when email
ddrads entersd

Send email at the same time every day.

Component

Component

Classic workfow

[}

| Power Automate fiow

You create a Power Automate flow as part of a managed solution. The flow alerts users when files are uploaded to a SharePoint location.
Files are uploaded to SharePoint at a much higher rate than expected. Users report that they receive too many notifications about uploaded files.

You need to stop the flow and correct the issue.

What should you do? To answer, select the appropriate options in the answer area.

NOTE: Each correct selection is worth one point.
Requirement

Disable the flow in the managed solution

Action

Verify changes to the flow

Disable the flow from the Power Automate portal
Disable the flow from the Azure portal
Disable the fiow from the Power Automate solution

Run the Flow checker and then turn on the updated flow

Use the Test feature on the updated fiow and then turn on the flow
Turn on the fiow and then use the Test feature for the updated flow

Run the Flow checker and then use the Test feature on the updated flow

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Graphical user interface, text, application Description automatically generated

Reference:

https://docs.microsoft.com/en-us/power-automate/edit-solution-aware-flow https://docs.microsoft.com/en-us/power-automate/error-checker
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NEW QUESTION 267

- (Exam Topic 3)

A company plans to implement Al Builder to add intelligence to several business processes. Each business process uses different sources and produces different
outputs.

You need to determine which Al Builder model types to use.

Which model types should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

Recognition requirement Model type
Identify a person’s age in a paragraph when wrtten v
using the pattern twenty years old Entity extraction
Text recogmition
Key phrase
Identify items and prices from an invoice v

| Form processing
Text recognition
Object detection

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Reference:
https://docs.microsoft.com/en-us/ai-builder/form-processing-model-overview https://docs.microsoft.com/en-us/ai-builder/entity-extraction-overview

NEW QUESTION 268

- (Exam Topic 3)

You create a JavaScript web resource named MyBusinessLogic. The code it contains uses functionality from a third-party JavaScript library.

You notice that an independent software vendor (ISV) solution uses the same third-party library in their managed solution.

You plan to deploy your solution to other environments by using a managed solution. The ISV solution might not be installed in the other environments.
You need to package the solution for deployment

What are two ways to achieve this goal? Each correct answer presents a complete solution.

NOTE: Each correct selection is worth one point.

A. Create a new JavaScript web resource by using the code from the third-party librar

B. Add the new JavaScript web resource along with MyBusinessLogic to the solution.

C. Add a copy of the JavaScript library from the ISV to the solution along with MyBusinessLogic.
D. Add the code from the third-party JavaScript library to MyBusinessLogi

E. Add MyBusinessLogic to the solution.

F. Add only the third-party JavaScript web resource to the solution.

Answer: AC

Explanation:

Web resources in model-driven apps.

Web resources are virtual files that are stored in the Microsoft Dataverse database and that you can retrieve by using a unique URL address.

Capabilities of web resources.

Web resources represent files that can be used to extend the Dataverse web application such as html files, JavaScript, and CSS, and several image formats.
Reference: https://docs.microsoft.com/en-us/power-apps/developer/model-driven-apps/web-resources

NEW QUESTION 271

- (Exam Topic 3)

A company is implementing Power Apps and Power Automate.

Several components are created within Power Apps. Microsoft Dataverse. and Power Automate. These components must be promoted from the development
environment to the user acceptance test environment in a single solution package.

You need to create the solution package for promotion. Where should you create the package?

A. Office 365 admin center

B. Azure DevOps

C. Power Apps designer

D. Microsoft Power Platform admin center
E. Azure portal

Answer: D

Explanation:

A solution package is a bundle of components, such as Power Apps, Power Automate, and Microsoft Dataverse, that can be promoted from one environment to
another. To create the solution package for promotion in a company that is implementing Power Apps and Power Automate, the package should be created in the
Microsoft Power Platform admin center.

In the Power Platform admin center, you can create a solution package that includes the necessary components and export it as a .zip file. This file can then be
imported into the desired environment, such as the user acceptance test environment, to promote the components.

References:
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> https://docs.microsoft.com/en-us/power-platform/admin/solutions/create-solution
> https://docs.microsoft.com/en-us/power-platform/admin/solutions/import-solution
> https://docs.microsoft.com/en-us/power-platform/admin/solutions/export-solution

NEW QUESTION 275

- (Exam Topic 3)

You configure and test a user interface (Ul) flow. You plan to run the flow as a scheduled flow.

The Ul flow must run on a Windows 10 device. As part of process automation, the Ul flow must sign into the Windows 10 device with the credentials for a user
account named Userl.

You need to ensure that the flow runs during non-peak hours and requires no physical user intervention. What should you do?

A. Ensure that all user sessions are signed out except for locked user sessions.
B. Ensure that the Userl account has an active user session on the device.

C. Ensure that all user sessions are signed out.

D. Ensure that there are no active user sessions on the device.

Answer: D

Explanation:
Reference:
https://docs.microsoft.com/en-us/power-automate/ui-flows/run-ui-flow

NEW QUESTION 277

- (Exam Topic 3)

You are a Dynamics 365 Customer Service administrator.

A user must be able to view system posts and activities in a dashboard. You need to create the dashboard for the user.
Which components should you use? To answer, select the appropriate options in the answer area.

NOTE: Each correct selection is worth one point.

Requirement Component
Display system posts v
Timeline
Organization insights
IFrame
Relationship Insights

Display activities v
Lists

Social Insights

Organization Insights
Relationship Insights

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Graphical user interface, text, application Description automatically generated

Box 1: Timeline

The timeline helps agents see all customer interaction history across channels, personnel, and the support lifecycle. The timeline is used across Dynamics 365
applications to capture activities like notes, appointments, emails, tasks, and more, to ensure that all interactions with the customer are tracked and visible over
time. Agents use the timeline to quickly catch up on all of the latest activity details with the customer to provide the most personalized support experience.

Box 2: Lists Reference:

https://docs.microsoft.com/en-us/dynamics365/customer-service/customer-service-hub-user-guide-timeline-adm

NEW QUESTION 281
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